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Welcome 

Trivantis is pleased to offer you Lectora Professional Publishing Suite.  With this product suite, you 
are equipped with all of the major editors to create your own multimedia files.  All programs within the 
Professional Publishing Suite are developed by Trivantis; therefore you are guaranteed the continued 
ease of use, flexibility, and seamless integration that is present in our entire Lectora product line.  By 
utilizing this Lectora Professional Publishing Suite User Guide in conjunction with the Lectora 
Publisher User Guide, all Lectora program functionality will be addressed and explained.   This guide 
specifically focuses on the multimedia editors included in the Professional Publishing Suite package.  

 
Prerequisites 

This guide assumes you have a working knowledge of your Windows® operating system and its 
conventions such as using a mouse, interacting with standard menus and commands, accessing your 
desktop, and opening and closing files. For help with any of these techniques, please refer to your 
Windows documentation. 

 
System Requirements 

• Intel® or AMD® class processor 
• 32MB RAM 
• 40MB free hard drive space for application 
• Windows® 98, NT, ME, 2000, or XP operating system* 
• Internet-published content is cross-platform compatible with Microsoft® Internet 
Explorer® version 4.0 and higher**, Netscape® version 4.7, 7.0 and higher, and Mozilla®. 

*The Lectora Unicode Edition is supported only under Windows NT 4 (SP4), 2000, and XP. 
CD-ROM published content produced by Lectora will run on any Windows computer that has a 
Windows operating system and a CD-ROM drive. 
 
 ** Trivantis recommends running IE 5.5 or higher. 
 
Note: To use the testing/form email submittal features of a Lectora published HTML title, a Macintosh 
based browser must support LiveConnect internet functionality. This functionality allows Javascript 
and Java to freely interchange data on a website. Windows based browsers already support this 
functionality. 
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Lectora Professional Publishing Suite  
 
Click on Start> Programs> Lectora Professional 
Publishing Suite or any one of the editors on the right. 
 
 
Editors can be used to create media files that enhance 
your Lectora created course, or can be used 
independently. 
 
 
 

Lectora Professional Publishing Suite Overview: 
 
 

Audio Editor 
The Audio Editor enables you to record, play, edit, and convert .WAV format audio files. You may 
want to edit audio tracks for overdubbing videos, creating special effects, or for general use. After 
you’ve recorded an audio (using an external microphone - not supplied), or selected one from your 
existing system, you can edit the audio in numerous ways (crop, fade in, fade out, silence, etc.), copy 
it to the Windows clipboard, or save it using a variety of compression formats. 
 

Image Editor 
The Image Editor enables you to easily manipulate images by cropping, resizing, rotating, filling, 
animating, and much more. In addition to modifying images, this editor also enables you to create 
your own drawings using a paint tool. 
 

Screen Camera 
Screen Camera records screen activity from your Windows desktop and can save it either as a video 
with optional audio, or as an animated GIF file. These files can be useful to demonstrate software, to 
create an interactive learning environment, and for many other uses. Screen Camera is built with a 
simple, easy to use interface that should have you ready to make your first movie in a matter of 
minutes.  
 

Screen Capture 
Screen Capture captures and saves any portion of the visual image of your Windows screen. You 
may want to do this to create step-by-step software demonstrations, display examples of Web pages 
you've designed, or capture an event on your system. After you've captured a screen image, you 
can manipulate it in a variety of ways.  
 

Video Editor 
The Video Editor enables you to play, edit, and convert .AVI format video files. You may want to add 
sound effects to existing videos, merge multiple videos into a single presentation, or copy audio 
tracks out of an existing video – all of these functions are available in the Video Editor.
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Audio Editor 
 
You can easily record new audio files using an external computer microphone. Add a new dimension 
to your content by incorporating voiceovers, sound effects, and background music. Easily create and 
import audio files or attach an audio file to a video frame that further explains those hard to show 
steps and procedures. In addition to recording your original work, you can also edit existing audio files 
with built in functionality to fade-in, fade-out, silence, and compress, adjust volume control and more. 
 
Incorporating audio files not only spices up your course content, but it also helps auditory learners 
that learn best while seeing, reading, and hearing course content. 
 
 
Recording a New Audio 
 
Record a new audio file by clicking on New from the File dropdown 
menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once New is selected, you will be presented with the following dialog box: 

 
 
This dialog box enables you to select the characteristics of the audio that you are about to record. 
The types of information that you can select/alter are: 

• Name – Select from: 
o [untitled] – add your own format and attribute settings and name it appropriately. For 

example: Set the Format and Attribute properties if you want to create your own 
setting that will be used multiple times. Click the Save As button. Give your new 
setting a name, and it will be saved under the Name setting for easy retrieval. 

o CD Quality – This is the highest quality and also the largest file size possible. 
Attribute will automatically be set to 44.100 kHz, 16 Bit, Stereo. The data transfer rate 
will be set to 172 kb/sec. 

o Radio Quality – This is considered middle of the road quality. 
22.050 kHz, 8 Bit, Mono. The data transfer rate will be set to 21 kb/sec. 
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o Telephone Quality – This is considered the lowest quality and also the smallest file 
size. Attribute will automatically be set to 11.025 kHz, 8 Bit, Mono. The data transfer 
rate will be set to 10 kb/sec. 
Tip: We recommend using Telephone Quality to record voice audio files. Voice 
ranges are pretty steady when it comes to changes in the voice range, and the file 
size will be manageable. 
 

• Format - the compression format used for the audio file. The options selectable within this 
control are based on the CODECs (Compression/Decompression modules) installed on your 
machine. Therefore there isn’t a set menu since it is machine specific. 

 
Tip: We recommend that you keep the format set to PCM if there is not a standard in place 
throughout your organization. PCM is a Windows compression CODEC that comes installed on 
all Windows machines. If you compress your audio file using a different CODEC other than what 
your end user will be using to decompress the file, the end user will not be able to decompress 
that file. Be careful in making this selection. 

 
• Attributes - the number of samples per second (listed in Hz), the size of each data sample (8 

Bit, 16 Bit, etc), and Monochrome or Stereo. 
The range goes from 8.000 kHz, 8 Bit, Mono, 7 kb/sec all the way up to 48.000 kHz, 16 Bit, 
Stereo, 187 kb/sec. 

 
Warning: Realize that each of these options has a large impact on the final size of the audio file that 
you are creating. If the audio you are creating is to be used as part of a web-based demonstration or 
presentation, then you may not want to go with the high-end attributes (48,000 Hz, 16 Bit, Stereo) that 
will result in a file more than 16 times larger than a file recorded at lesser quality (11,025 Hz, 8 Bit, 
Mono). 
 
Once the Audio Format selections are made, click OK. You are now ready to record. 
 

The Control Panel display enables you to perform the standard tape machine operations on the 
current audio (play, stop, pause, record, etc.) The individual controls will enable/disable themselves 
based on the current operating mode of the Audio Editor. 

The functions of these buttons are as follows: 

 
 

 
 
 
 
 
 

• Stop - stops the Audio E . 
Play - will begin playback o

ditor while in either playback or record mode
• f the current audio. If a selection is currently active, playback will 

• rd of an audio. Pressing this button a second time will 

• ture from the currently selected audio input device. 

•  - will move the current position in the audio to the end of the audio file. 

consist only of the current selection. 
Pause - will suspend playback or reco
resume playback or record. 
Record - will begin audio cap

• Go to Start - will move the current position in the audio to the beginning of the audio file (time 
0:00.00). 
Go to End
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• Begin Selection - will mark the starting point within the audio that you wish to edit. 
• End Selection - will mark the ending point within the audio that you wish to edit.  

 
 

After you have recorded an audio or opened an ex ting audio for edit, the Audio Sample Display 
 

le 

he Audio Sample Display window will automatically update itself with changes to the source audio, 

est 

he current position within the audio is designated by a solid white line stretching from the top of the 

hen using the slider to control the current position within the audio file, the Audio Sample Display 

 
is

window will show you a representation of the current audio. If the audio track is stereoscopic, both
channels (left and right) will appear in the window. To the right of the display, the Audio Sample sca
appears, and the time scale of the audio appears below the display. The current location in the audio 
can be changed by using the slider beneath the display, or by using the mouse to click in the Audio 
Sample Display window. 
 
T
and will illustrate selections within the audio by inverting the display for the selected region. If you 
resize the Audio Editor window, the Audio Sample Display will expand/contract itself to make the b
use of the available space within the Audio Editor window. 
 
T
display down to the Time Scale region of the display. 
 
W
will be automatically scrolled to keep the current position displayed regardless of the Zoom Level. 
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The Time Display enables you to visually see (in addition to the highlighting within the Audio Sample 
Display) the currently selected portion of the audio, the length of the current selection, and the 
position within the current audio. If there is no current selection, the Length Selection represents the 
length of the entire audio. The Current Location always represents the position within the audio file as 
a whole (not within a current selection). 
 

 
 

Once you have created a new audio, or loaded a pre-existing file from your file system, you may wish 
to change the characteristics of the audio (alter compression options, degrade the number of 
samples, convert to mono from stereo, etc.). To accomplish this, just select the Save As option from 
the File menu. At the right side of the Save As dialog, will appear the current audio characteristics: 

 

Also available is a Change Format button that will enable you to select the new characteristics of the 
audio (the same as when you Record a New Audio). (Refer to page 10, Audio Format) 

Tip: Keep in mind that when you convert audio formats, it is usually wiser to degrade the quality of 
the audio then to try to increase the quality. You are always limited by the quality of the source 
material, and if you have a scratchy audio at 11 kHz, upgrading it to 48 kHz will just give you more 
samples of a scratchy recording. 
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Select Audio Range 

• Use Begin/End Selection buttons ( ) - The current selection will be 
expanded/contracted when pressing the appropriate button based on the current position 
within the audio. You can modify the current position in the audio file by using the slider 
control below the Audio Sample Display to move the current position. 

OR 
• Use the mouse/keyboard within the Audio Sample Display - When you first click in the Audio 

Sample Display (using the left mouse button), you will move the current position within the 
audio to this location. If you hold down the left mouse button and drag the cursor left-or-right, 
the audio selection will automatically expand/contract to follow the mouse. To expand a 
current selection, hold the SHIFT key down when you click and the selection will expand 
(either the starting or ending point) to include the location where you just clicked. 
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Edit Existing Audio Recordings 
 
The Tools menu includes several common tasks that you will want to use while editing your audios: 

 
 

• Crop - deletes the unselected portion of the audio. (Select the portion of the audio that you 
want to use by setting the Begin Selection and End Selection buttons). 

 
o  Fade In - takes the currently selected audio portion and fades in the volume linearly across 

the entire selection region 
 
 
 
Notice in the display window the first 
5.96 seconds of the audio file is 
gradually faded-in. By looking at the 
time display, it shows that fade in will  
begin at 00.00 and end at 05.96. 

 
 

 
 
 
 

o Fade Out - takes the currently selected audio portion and fades out the volume linearly 
across the entire selection region. This will work just like the fade in display above. 
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• Silence - if there is a currently 
selected region, the Audio Editor 
replaces the audio in the selected 
region with silence. If there is not a 
selected region, a dialog is 
presented asking how many 
milliseconds of silence you wish to 
insert in the audio at the current 
position in the audio. Remember, 
1000 milliseconds = 1 second. 

 
 
 

The Audio display shows that there is silence between the 
12th second and the 16th second of the audio file. 

 
Zoom In/Zoom Out 
 
If you are dealing with an extremely long audio file, you may wish to zoom in on portions of the 
display. This feature is available via the View menu or by using the keyboard shortcuts: 
 

• Zoom In - press the Shift key and the UP ARROW key on the keyboard 
• Zoom Out - press the Shift key and the DOWN ARROW key on the keyboard 

 
When you are Zoomed In to an audio, the Audio Sample Display will automatically scroll during 
playback to keep the current position within the audio displayed at all times. You can also use the 
slider control below the Audio Sample Display to scroll the image. 
 
Note: There is a limit to how far you can zoom into an audio, which is based on memory limitations 
available on the machine where the Audio Editor is running. 
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Audio Editor Preferences 
 
The Preferences Dialog box enables you to define the preferred playback and record devices to be 
used by the Audio Editor. By default, the Audio Editor uses the Microsoft Sound Mapper to choose 
the appropriate device to use during playback/record for a particular audio. If you have no idea what 
to select in this dialog, just use the defaults (Microsoft Sound Mapper). 
 
If you happen to have multiple input or output sound cards on your machine, you may wish to 
specifically select one of these devices based on your desires for the current audio. 
 
The options check boxes show what the device claims it can handle during the corresponding 
playback/record session. If you want a specific sound format that is not checked (i.e., supported) by a 
specific wave device, then you will be unable to use that device. 

 
If during playback or record you receive an error that states, “The currently selected input/output 
device cannot handle the current request; try selecting the Microsoft Sound Mapper as the device.” 
Even if there is only one associated device on your computer, the Sound Mapper achieves certain 
functions through a software implementation instead of using the services on the actual sound device. 
 
Select Preferences from the File drop down menu. 
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Image Editor 
 

The Image Editor enables you to create new images and modifying existing ones. With the Image 
Editor, you can perform a variety of tasks that will make you an image editing pro in no time: 
 

• Save to a variety of web-friendly image formats (JPEG, GIF, TIF, etc.) 
• Easily add text annotation to your existing pictures 
• Crop, Scale, and Rotate the entire image or just portions of the image 
• Apply standard imaging effects to your pictures (Posterize, Mosaic, Emboss, etc.) 
• Edit Animated GIFs 
• Draw simple and complex shapes 
• Use a variety of painting tools to get just the right look 

 
These complex tasks are performed quickly and easily within the Image Editor, which will create new 
content in a fraction of the time that other imaging products require. 
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Supported File Types 
 
The Image Editor supports a wide variety of image formats for both input and output: 
 

• Windows Bitmap Files (*.bmp) 
• Graphics Interchange Format (GIF) files (*.gif) 
• Joint Photographic Experts Group (JPEG) files (*.jpg) 
• Tagged-Image File Format (TIFF) files (*.tif) 

 
BMP is the standard Windows image format for DOS and Windows-compatible computers. The BMP 
format supports RGB (Red Green Blue) and Indexed modes (see Image Concepts for more 
information). 
 
GIF is the file format most widely used on the Internet. The GIF format supports the Indexed color 
mode. In addition, GIF supports transparency within the image that allows colors/images underneath 
the image to show through (see Color Palette for a more detailed description of transparency). 
 
JPG is the file format most widely used to display photographs on the Internet. The JPG format 
supports both RGB and Indexed color modes. The JPG format differs from the other formats 
discussed in this section because it uses compression techniques that selectively discard data to 
achieve its high level of compression (reduced file size). This allows for a smaller file to store the 
image within (i.e., faster download time) than those image formats that do not discard data, but the 
downside is that the image now no longer contains all the original source data. This is known as 
“lossy” compression, because the uncompressed image is a fairly faithful representation of the 
original source image, but there are compression artifacts that show slight differences between the 
compressed image and the original. 
 
TIFF is a widely used file format for exchanging files between applications on various computer 
platforms. The TIFF format supports both RGB and Indexed color modes. Virtually all paint 
applications, page-layout tools, and desktop scanners support this format. 
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Image Concepts 
 
An image is nothing more than a collection of colored (yes, even white and black are colors) dots that 
are arranged in rows to present a graphical representation to the user. These dots are the units of 
measurement of an image and they are more commonly referred to as pixels or pels.  
 
The pixel is defined as the smallest unit that represents a single color within an image. The number of 
pixels along the width and height of an image define the dimensions of that image. For instance, an 
image that is referred to as 800x600 is in actuality an image that is 800 pixels in width and 600 pixels 
in height. This size is fixed within the image. 
 
When an image is displayed, the size of the image is determined by the resolution of the display 
device (monitor, printer, etc.). For example, a typical 15-inch monitor displays a resolution of 800 
pixels horizontally and 600 pixels vertically. The image referred to previously, would completely cover 
the screen when displayed on this monitor. If a larger monitor were used, the same image would 
occupy a larger physical size (as presented to the user), even though the image is still only 800x600. 
If the larger monitor is set to a higher resolution than 800x600, the image displayed will only occupy a 
portion of the screen, and will be potentially closer in “size” to the image displayed on the 15-inch 
monitor. 
 
Each of these pixels represents a single color in the source image. So how are the colors defined? 
Colors are defined using a concept called bit depth. This is also referred to as pixel depth or color 
depth. What this means is that a color is defined by the amount of information (or data) required to 
specify the color.  This is why we refer to color depth as bit depth because the number of bits of data 
required to define the color tells us how many possible colors can be supported by the image. 
 
For instance, a bit depth of 1 has only two possible colors: black and white. A bit depth of 8 has 256 
possible colors, and a bit depth of 24 has over 16 million possible colors.   
 
When we refer to indexed color modes, we mean that the image has a color table that holds the 
actual color values, and the data of the image is represented not by color values, but by indices into 
the color table of the image. When we refer to RGB mode, we mean that the data of the image is 
ordered in intensity values for the Red, Green, and Blue phosphors that are used to present the 
image.  Indexed color modes restrict the number of colors that are contained in an image to 256 
colors, while RGB color modes allow the much wider range of representing images.   
 
Color resolution (also called color depth) refers to the number of possible colors in an image, as 
determined by the bits-per-pixel. If an image in your computer is loaded from a FAX scanner or 
received as a FAX transmission, it is a black-and-white (1-bit) image. If it is loaded from a color 
scanner or a JPEG file, it can have 16 million colors. If it is loaded from a GIF file, it is likely to have 
256 colors. There are many possibilities, ranging from two colors to 16 million. 
 
The Image Editor enables you to manipulate an image and display it on any Windows-compatible 
device, regardless of the image's color resolution. Therefore, in most cases you can load, display, 
modify, and save an image without ever changing its color resolution. Nevertheless, in some cases 
you may need to increase or decrease the color resolution. Here are some examples: 
 

Suppose you need to load a large 24-bit image on a computer that does not have 
much memory. You can conserve memory by loading it as an 8-bit image. Then, if 
you were using an 8-bit display device, you would not see any difference in the 
quality of the image. Of course, there would be some loss of quality on a 24-bit 
display device, and the loss would be permanent if you then saved the image in the 
same file. 
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Suppose you want to save an image in a different file format. If the new file format 
does not support the original color resolution, you can specify a different color 
resolution when you save the image. 
 
Suppose you want to combine one 8-bit image with another one. To combine two 
images, they must have the same color resolution, and if they are less than 16 bits 
per pixel, they must use the same palette. The simplest solution is to convert both 
images to 24 bits per pixel before combining them. Then, if necessary, you can 
reduce the color resolution of the combined image. 

 
Whenever you reduce an image's color resolution to 8 bits per pixel or less, a dithering method 
comes into play. One alternative is to use a nearest-color match (no dithering), which means that the 
color of each pixel is changed to the palette color that most closely matches it. If the original image 
contains subtle color details, the result of a nearest-color match may have large blotches of color that 
are not very pleasing. 
Dithering methods create the appearance of more subtle shades by mixing in pixels of different 
colors. This is similar to the way newspaper pictures produce the appearance of shades of gray, even 
though the only actual colors are black and white.  
 
Ordered dithering is the fastest method. It is the default dithering method when painting to a display 
device that is 256 colors or less. Ordered dithering takes advantage of the fact that the colors in most 
palettes are ordered so that similar shades are next to each other in the palette. This method avoids 
blotches of color by adding to or subtracting from the nearest-color value of each pixel to ensure that 
adjacent pixels do not have exactly the same color. (If the colors in the palette are not ordered, the 
results are not good.) 
 
All of the other dithering methods in the Image Editor use error-diffusion algorithms. In error diffusion, 
the error is the difference between the original pixel color and the nearest match, and diffusion of this 
error is what the algorithm accomplishes. Floyd-Steinberg is a high-quality, fast error-diffusion 
method. It is the default method that the Image Editor uses if you reduce the color resolution when 
loading or saving an image, or if you specify error diffusion as the dithering method when painting to a 
display device that is 256 colors or less.  
 
If you use the Color Resolution option in the Image Editor to change the color resolution of a bitmap 
in memory, you can choose from a list of possible dithering methods. All of the alternative error-
diffusion methods are slower than Floyd-Steinberg, and the quality may or may not be better, 
depending on the original image, and depending on whether the resulting image is to be displayed or 
printed. Choosing an alternative dithering method is a subjective, trial-and-error decision. Stevenson 
and Arce dithering, the slowest of the alternatives, is most likely to produce a higher quality result. 
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Paint Toolbar 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Paint Toolbar contains all the basic editing tools used by the Image Editor. To select a 
tool, click on the appropriate button within the toolbar. Once a tool has been selected, the 
Tool Options display will contain sub-selections available for the currently selected tool. 
 
The Paint Toolbar can be docked at one of the sides of the Image Editor, or you can make it 
a floating toolbar by dragging the toolbar outside the main Image Editor window. 

 
Section Tool 
 

 Section Tool - Enables you to define an area (region) that you can use with the standard 
editing commands (Cut, Copy, Paste), some of the other tools, image effects, and spatial 
filters. To select an area, click on the Selection Tool, and then click on the image with the 
left mouse button and drag the mouse to highlight the area you will be selecting. When you 
have the area highlighted that you desire, release the left mouse button to finalize the 
selection. You will now have a selection layer that is a copy of the contents within the 
selection. If you move the cursor over the selection area, the cursor will change to a Hand 
cursor, showing that you can now Move the selection to another part of the image. 

 
To Copy the selection, use the Copy command from the Edit menu, or use the keyboard 
accelerator CTRL-C. 

 
To Delete the selection, use the Delete command from the Edit menu, or use the keyboard 
Delete button. When you delete a selection, the selection is replaced with the Background 
Color (see Foreground / Background Colors for more information). 
 
You can now select one of the other tools (such as Fill Tool) to use with the selected area. 
To remove a selection, just click on an area outside of the selection.  
 
When you choose the Selection Tool, you can pick from several different selection types: 
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The Rectangle option is the most common selection tool, and will create a rectangle 
between the starting selection point and the ending selection point. 
 
The Rounded Rectangle option is similar to the Rectangle option, except with rounded 
corners. 
 
The Triangle option will create a selection in the shape of a triangle. 
 
The Polygon option will create a multi-sided selection placing a point everywhere you use 
the left-mouse button after the initial click. To close the shape, just double-click on the 
image with the left mouse button. 
 
The Circle option will create circular and oval selection regions. 
 
The Freeform option enables you to define exact areas of the image that you wish to work 
with. After you select this option, just click the left mouse button on the image and drag the 
mouse around (holding the left button) down, to highlight the area you wish to select. Once 
you have the area pretty much defined, release the left mouse button, and the selection will 
automatically close itself. 

 
 
Pen Tool 
 

  The Pen Tool enables freeform drawing of lines on the image using the currently selected 
Foreground color. Once you select this tool, just use the left mouse button to start drawing. 
As long as you have the left mouse button depressed, you can move the pointer across the 
image and draw a freeform line. Once the left mouse button is released, the current freeform 
line is completed. 

 
Paint Brush Tool 
 

  The Paint Brush Tool enables you to draw freeform strokes on your image using a variety of 
brush shapes. Select the tool and then choose one of the various brush styles and sizes.  

  
Then use the left mouse button within the image to begin drawing. As long as the left mouse 
button is depressed, the brush tool will stroke a continuous path using the selected style 
and size until you release the left mouse button. 
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Eraser Tool 
 

  The Eraser Tool enables you to remove portions of the image and replace it with the 
currently selected Background Color (see Foreground / Background Colors for more 
information). Once you select the tool, click the left mouse button and drag the cursor over 
the area of the image that you want to erase. 

 
When you choose the Eraser tool, you can select from a variety of sizes to remove: 

 
 
 
Fill Tool 
 

  The Fill Tool uses the current selected Foreground Color to fill an area of the image (see 
Foreground / Background Colors for more information). If you click within a selection region 
(see Selection Tool), the entire region is replaced with the Foreground Color. If there is not a 
selection present, the Fill Tool will fill all adjoining pixels that have the same color as the 
pixel you clicked on in the image. 

 
Color Picker Tool 
 

 The Color Picker Tool (also known as the Eye Dropper) is used in conjunction with the 
Foreground / Background Colors display to select the current foreground or background 
color from the current image. Select the tool, and then move the pointer over the image. If 
you use the left mouse button, the current color under the pointer will be used to set the 
current Foreground color. If you use the right mouse button (or press and hold the CTRL 
key while using the left button), the Background color will be set. 

 
 
Zoom Tool 
 

  The Zoom Tool is used to easily zoom into and out of the current image so that finer detail 
work can be done on the image. To Zoom In on the image, select the tool and use the left 
mouse button to click on the portion of the image that you wish to enlarge. If you wish to 
Zoom Out, just click the right mouse button within the image. 

 
 
Magnify Tool 
 

 The Magnify Tool is a powerful tool that can quickly zoom into a portion of the displayed 
image. You select this tool from the Tool menu, and when you place the mouse over the 
image, the pointer changes to the square magnifying glass. If you click and hold the left 
button down, the magnify window appears which you can move around the image as long 
as the left mouse button stays depressed. A sample of this tool in action appears below: 
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Spray Tool 
 

 The Spray Tool (also known as the Air Brush Tool) enables you to create an airbrush 
effect on your image. Select the tool and the size of the spray area (either small, 
medium, or large), and then press and hold the left mouse button over the image. If you 
hold the mouse still while depressing the button, the spray will concentrate in that area 
(as if you used the normal Paint Brush Tool). You can create numerous effects using 
this tool (from adding snow to a scene, to removing harsh edges to an image. 

 

   
 
 
Text Tool 

  The Text Tool enables you at add annotations to your images. Select the tool, and then 
click where on the image you wish to place the text. The following dialog will be 
presented where you can specify the attributes of the text to add: 
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The Text font/color button will invoke a standard Windows font selection dialog where you 
can select the font style, size, color, and attributes (bold, italic, underline, strikeout). Once 
you have selected the font, this dialog will display the new attributes of the font. 

The Antialias text option will switch between using an Antialiased quality font or a Draft 
quality font. 

The Leave text background transparent option is used in conjunction with the 
Background Color selection to determine whether the text will be added transparently to 
the image, or whether the bounding box of the text will be filled with the Background 
Color. 

Once you have entered the text you wish to add to the image, just press the OK button to 
add the annotation to the image. 

 

Line Tool 

 The Line Tool enables you to draw straight lines of varying thickness on the image. 
Select the tool, and then use the left mouse button to mark the line on the image. When 
you release the left mouse button, the line will be drawn between the initially selected 
point and the ending point using the line thickness you selected. 

    The line thickness can vary in width from 1 to 9 pixels.  
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Curve Tool 

The Curve Tool enables you to define a Bézier Curve of varying thickness on the image. 
A Bézier Curve is defined by four (4) points: a starting point, an ending point, and two 
control points (one for each the starting and ending points). With these four points, a 
Bézier Curve can be drawn. 

   To draw the curve, select the initial point and drag the pointer to the ending point. Then 
use the mouse to input two more points that will be used to determine the slopes of the 
curve between the start and ending points. Like the Line Tool, the Curve Tool supports 
multiple widths that vary from 1 to 9 pixels. 

 
Rectangle Tool 

 The Rectangle Tool enables you to draw a rectangle using the current Foreground 
and/or Background colors (see Foreground / Background Colors for more information). 
Select the tool, and use the click/drag option to define the rectangle you want to draw. 
Once you release the left mouse button, the rectangle will be drawn based on the sub-
tool selection you choose: 

 

If you select the Rectangle option, only the border of the rectangle will be drawn using the 
currently selected Foreground color. 

If you select the Filled Rectangle w/ Border option, the border of the rectangle will be 
drawn using the currently selected Foreground color and the rectangle will be filled with 
the currently selected Background color. 

If you select the Filled Rectangle No Border option, the rectangle will be filled with the 
Foreground color. 

 

Round Rectangle Tool 

   The Round Rectangle Tool is identical to the Rectangle Tool, except that the corners of 
the drawn rectangle are rounded. 

 

Oval Tool 

  The Oval Tool enables you to draw ovals using the current Foreground and/or 
Background colors (see Foreground / Background Colors for more information). The 
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Oval Tool behaves identically to the Rectangle Tool except that the area drawn is an 
oval or circle instead of a rectangle. 
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Polygon Tool 

   The Polygon Tool enables you to draw multi-sided shapes using the current Foreground 
and/or Background colors (see Foreground / Background Colors for more information). 
Select the tool, and use the left mouse button to start the polygon. For each vertex you 
wish to set, click the left mouse button. When you have finished creating the sides of the 
polygon, double-click the left mouse button to close the polygon shape. See the 
Rectangle Tool to see how the sub-select tool options work. 

 

Foreground/Background 

 

The Foreground / Background Color Tool enables you to set the colors used by the normal painting 
tools when altering the image. The Foreground color is the color used by the drawing tools to draw on 
top of the image. The Background color is the color used when you delete a selection from the 
current image. If you want to change the Foreground or Background color, just double click the 
appropriate square to display the Windows standard Color dialog: 

 

With this dialog, you can select any of the predefined Basic colors, or you can select a custom color 
by inputting direct RGB values or selecting the color from the display window. 
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Once you have a selected Foreground and Background color, you can swap the two colors by 
selecting the Swap indicator in the upper right corner. If you want to reset the colors to Black and 
White, just select the Black/White indicator in the lower left corner. 
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Color Palette 
 
The Color Palette is a dockable toolbar that enables you to see the colors used by the current image 
if you are in 8-bit color mode or lower resolution (see Image Concepts for more information). This 
dockable window also enables you to set the Foreground and Background colors by using the left and 
right mouse buttons respectively to set the colors (see setting the Foreground / Background Colors 
for more information). 
 

 
 
If you are saving to a file format that supports transparency (such as GIF), you can select the 
transparent color by choosing the Enable Transparency option, and then pressing the Pick Trans 
Color button. This feature is only available if the current image is in 8-bit color mode. An “X” in the 
color table entry indicates the current transparent color index in the palette. 
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Animation Tool 
 

 
 
The currently selected frame is indicated by the blue highlight in the thumbnail pane to the left, while 
the image itself is in the right hand pane and is editable. By selecting different thumbnails in the left 
pane, you can quickly switch between images displayed in the right hand pane. By right-clicking in the 
thumbnail pane, you can access the same tools that are available from the drop down Animation 
menu that pertains to individual frames. In addition to the standard editing abilities, you can also: 
 
Add/ Delete/ Edit Frames 

The Animation Tool enables you insert and delete frames into the animation based on the currently 
selected frame in the thumbnail pane. If you select to Add a Frame from either the popup or 
application menus, you will be inserting a blank frame after the currently selected frame in the 
animation. If you select to Delete a Frame, you will be deleting the currently selected frame in the 
animation. 

The Animation Tool also supports the standard editing features of Cut, Copy, and Paste. These 
features work in conjunction with the Windows clipboard for copying/transferring data. 
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Frame Properties 
 
If you select the Frame Properties option from either the popup menu or the main Animation Tool 
menu, you will be presented with the following dialog that will allow you to alter the delay times 
between animation frames. Double-clicking in the thumbnail pane on the frame you wish to alter can 
also access this dialog. 
 

 
 
The Delay amount you input can set how long the individual frame will display before the next frame 
replaces it in the animation sequence.  
 
Play/Stop Animation 

When you have completed editing your animation using the Animation Tool, you can test the way the 
animation will appear to your intended audience by using the Play and Stop commands. The 
animation will play in the right pane of the Animation Tool and use the delays you have set via the 
Frame Properties dialog. 

Select Play or Stop from the Animation drop down menu to either play or stop the animation.  
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Loop 

An animation typically plays either a set number of times or it plays forever. This control over the 
animation is known as the Loop control of the animation. The following dialog allows you to set the 
loop counts that control the playing of the animation: 

 
 
If you select the Loop forever option, the animation will play until the application software unloads the 
animation. 

  
If you select a specific Loop count, then the animation will only display once more than the number of 
times that you select. Thus, if you want the animation to only play once and never repeat, set this 
value to 0. The range for this value is 0 to 1000. 
 
 
Image Translation 
 
The Image Translation options apply a transformation to the image as a whole. For each of the 
following translations, the action applies to the image as a whole (except where noted). 
 
The Image Translation options included in the Image Editor are: 
 
Flip:  The Flip translation takes the image and swaps the data from top to bottom (left to 

right is unaffected). Performing this translation a second time will restore the original 
image. 

 
Reverse:   The Reverse translation takes the image and swaps the data from left to right (top to 

bottom is unaffected). Performing this translation a second time will restore the 
original image. 
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Rotate: The Rotate translation will rotate the image (about it’s center) the specified number of 
degrees. The standard options supplied with the Image Indicator are: 
• 90 degrees clockwise 
• 180 degrees clockwise 
• 270 degrees clockwise 
• Any Angle 

 
 If you select Any Angle, the following dialog will appear: 
 

  
 

The Angle you specify can be anywhere in the range from –360 to +360 degrees. When 
rotating the image, you can tell the Image Editor to Resize the final image to 
accommodate the extra size required in both the horizontal and vertical directions. If you 
do not Resize the image, the portions of the image that are rotated out of the displayable 
view will be lost. 
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Shear: The Shear translation applies an angle of slant in either the horizontal or vertical 
direction. This translation adjusts the corners and sides of the image to create a 
parallelogram. 
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Resize: The Resize option enables you to adjust the pixel dimensions, print dimensions, and 
resolution of your image. When you select this option, the following dialog appears: 

 

  
 
 When specifying a new size for the Width and Height of the image, you can enter either 

an exact pixel size or a percentage of the current pixel size that you want to change. The 
Resolution of the image effects how large the image will appear when displayed on 
different devices (monitors, printers, etc.). Resolution is measured in units of dots per 
inch or dpi. In this unit, dots and pixels are synonymous. 

 
When Resizing an image, you can specify to Maintain Aspect Ratio which, will always 
force the width and height to be scaled similarly.   

 
Keep in mind that bitmap data is resolution dependent; therefore, if you change the 
dimensions of a bitmap image you may cause a loss in image quality and/or sharpness. 
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Crop: If you have a current selection defined, you can Crop the image to the selection. This will 
discard all the non-selected areas of the image and make the contents of the selection 
become the image. 
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Canvas Size: The Canvas Size command enables you to add or remove workspace around an 
existing image. When you select the Canvas Size option, you will be presented the 
following dialog: 

 
 

  The Current Size of the image displays the current pixel dimensions for the image. If 
you select to increase the size of the image, the current image will be centered within 
the new canvas and the added canvas will be added with the current background 
color used to fill the new space. If you specify a smaller canvas size, the image will 
be Cropped about its midpoint. 
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Image Effects 
 
The Image Effects options apply an algorithm to the image to produce the desired effect. For each of 
the following effects, the algorithm is applied to the current selection (or the image as a whole if there 
is no current selection). In all of the Image Effect dialogs, the Before and After windows enable you to 
see the result on your image without touching the source image. The Before and After displays can 
also be used to drag the displayed area of the image if the 1:1 button is depressed. 
 
The Image Effects included in the Image Editor are: 
 

• Posterize  
• Mosaic  
• Average (or blur)  
• Median  
• Sharpen  
• Despeckle  
• Add Noise  
• Emboss  
• Underlay  
• Edge Enhance  
• Oilify  
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Posterize:  The Posterize effect quantizes the image’s colors to a specified number of color 

levels per plane. In the following example, the value of 4 means that there are 4 
levels available for red, 4 levels available for green, and 4 levels available for blue. 
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Mosaic:  The Mosaic effect divides the image into tiles of a specified size and changes the 
color of the pixels within the tile to the average color of the original pixels within the 
tile. This results in an effect as follows: 

   
By adjusting the Tile size, you 
will create larger or smaller 
squares (tiles) in the resulting 
image. 
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Average (or blur): The Average effect changes the color of each pixel in the image to the 
average color of pixels in its neighborhood. This results in a blur effect as 
illustrated below: 

 

  
 
 You can modify the effect by changing the Sample size of the neighborhood 

that is used for calculating the average value. 
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Median: The Median effect changes the color of each pixel in the image to the median 
color of pixels in its neighborhood. This is similar to the Average effect, but it 
used for noise reduction rather than a blur effect. 

 

  
 
 You can modify the effect by changing the Sample size of the neighborhood 

that is used for calculating the median value. 
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Sharpen: The Sharpen effect is used to increase or decrease the sharpness of the 
image. Specify –100 for minimum sharpness. Specify +100 for maximum 
sharpness. 

 
Sharpening is used to help focus somewhat blurry images by increasing the 
contrast of adjacent pixels. The filter will first try to locate areas of the image 
where significant color changes occur (typically edges), and then sharpen the 
areas (edges) by increasing the contrast of the target pixel. 
 

 
 
 
 
Despeckle: The Despeckle effect is used to remove speckles (little blotches) from an 

image. This effect is most widely used to clean up scanned images (such as 
FAX images). 

 
The Despeckle effect detects the edges in an image (those areas where 
significant color changes occur) and then blurs all of the selection area 
except for those edges. This blurring will remove noise while preserving 
detail in the image. 
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Add Noise:  The Add Noise effect adds random pixels to the image, letting you specify 
the percentage of coverage and the color plane that the pixels represent. 

 

  
 
 If you select the Master channel, then all color channels (Red, Green, and 

Blue) will be effected. 
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Emboss: The Emboss effect makes an image appear to be raised or stamped by 
converting the fill color to gray and tracing the surface edges with the original 
fill color. You can specify the depth and direction of the apparent light source 
when applying this effect. 

 

  
 
 
 
Underlay: The Underlay effect combines the source image with a second image so that 

one appears to be an underlying texture for the other. This is most effective 
when the underlying image is a filtered one, such as an embossed image. 
You must have two or more images option in the Image Editor for this effect 
to be used correctly (otherwise you cannot specify a distinctly different image 
for the underlay). 

 
When you choose to underlay, you can specify whether the underlying image 
is tiled or stretched to fit the image. 

 
 
Edge Enhance: The Edge Enhancement effect finds areas in the image where significant 

color changes occur and sharpens them. This sharpens only the edges and 
preserves the overall smoothness of the image. 
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Oilify: The Oilify effect applies an oil-painting effect to the image.  By increasing the 
Sample size used in this effect, you reduce the overall detail in the image. An 
example of the Oilify dialog follows: 
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Image Spatial Filters 
 
The Image Spatial Filters options apply an algorithm to the image to produce the desired effect. For 
each of the following effects, the algorithm is applied to the current selection (or the image as a whole 
if there is no current selection.) In all of the Image Spatial Filter dialogs, the Before and After windows 
enable you to see the result on your image without touching the source image. The Before and After 
displays can also be used to drag the displayed area of the image if the 1:1 button is depressed. 
 
The Image Spatial Filters included in the Image Editor are: 
 

• Gradient  
• Laplacian  
• Sobel  
• Prewitt  
• Shift & Difference  
• Line Segment 

 
 
Gradient: The Gradient Filter detects edges in the image using a gradient directional 

filter. All pixels that are not on the detected edges are changed to blank. You 
can modify this filter by choosing the direction of the edge detection 
algorithm. An example of this filter appears below: 
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Laplacian: The Laplacian Filter detects edges in the image using a Laplacian line 
detection algorithm. All pixels that are not on the detected edges are 
changed to blank. You can modify this filter by choosing one of three omni 
directional filters, or by choosing one of the three bi-directional filters. An 
example of this filter appears below: 
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Sobel Filter: The Sobel Filter detects edges in the image using Sobel edge detection. All 
pixels that are not on the detected edges are changed to blank. You can 
modify this filter by choosing either Horizontal or Vertical detection. An 
example of this filter appears below: 
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Prewitt Filter: The Prewitt Filter detects edges in the image using Prewitt edge detection. 
All pixels that are not on the detected edges are changed to blank.  You can 
modify this filter by choosing either Horizontal or Vertical detection. An 
example of this filter appears below: 
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Shift and Difference: The Shift and Difference Filter detects edges in the image using shift-and-
difference edge detection. All pixels that are not on the detected edges are 
changed to blank.  You can modify this filter by choosing the appropriate 
value for diagonal, horizontal, or vertical detection. An example of this filter 
appears below: 
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Line Segment: The Line Segment Filter detects edges in the image using line segment edge 
detection. You can use this filter to find line discontinuities in the image. All 
pixels that are not on the detected edges are changed to blank. You can 
modify this filter by choosing the appropriate value for horizontal, vertical, 
left-to-right diagonal, or right-to-left diagonal detection. An example of this 
filter appears below: 
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Color Options 
 
The Color options enable you to convert an image from an existing color scheme to a different color 
scheme, and adjust color values (brightness, contrast, hue, etc.). In all of the Color dialogs, the 
Before and After windows show the result on your image without touching the source image. The 
Before and After displays can also be used to drag the displayed area of the image if the 1:1 button is 
depressed. 
 
The Color scheme options included in the Image Editor are: 

• Halftone  
• Gray Scale  
• Color Resolution 

 

 
 
The Image Editor enables you to alter the image by adjusting the hue, saturation, and lightness of the 
entire image or of an individual color component in the image. Adjusting the hue (or color) represents 
a move around the color wheel, while adjusting the saturation (or purity) represents a move across 
the radius of the color wheel.   
 

• Brightness  
• Contrast  
• Hue  
• Saturation  
• Gamma  
• Intensity Detect  
• Intensity Stretch  
• Histogram_Equalize  
• Histogram Contrast  

 
Some other useful color tools include: 
 

• Invert  
• Fill  
• Solarize  
• Unique Colors 
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Halftone 
 
The Halftone color option converts a bitmap with any resolution to a halftoned bitmap, with a specified 
pattern rotation. A halftoned bitmap is a 1-bit bitmap that has been dithered for black and white 
printing or display. When halftoning an image, you can decide between output that is appropriate for 
Viewing or Printing. If the image is not for printing, then you should always select the View option. An 
example of this color resolution appears below: 
 

 
 
 
 
Gray Scale 
 
The Gray scale color option will automatically convert the current image (or selection) from a 1-, 4-, 8-
, 16-, 24-, or 32-bit bitmap to an 8-bit, 12-bit, or 16-bit grayscale bitmap (whatever is appropriate). 
 
 
Color Resolution 
 
The Color Resolution option enables you to convert the color depth (see Color Options) of the current 
image. You can use this option to either increase or decrease the color depth (number of allowable 
colors) in the current image. If you select any of the color resolutions that are 8-bit color or lower, you 
will be able to select a dithering method and a palette to apply when converting the image. The 
palette chosen will become the palette for the image. 
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If you wish to save your image to an image format that does not support the current color depth of 
your image, then you will need to use this option to degrade the number of colors in your image to fit 
the requirements of the destination image format. For example, if you try to convert a 24-bit JPG 
image to the GIF format, you will need to change the color depth of the image to 8-bit color (or less) 
before the Image Editor will allow you to save the image in the new format. 
 
 
Brightness 
 
The Brightness color option changes the intensity (brightness) of the image. The intensity of the 
image can be changed from –100 (darken) to +100 (lighten). This adjustment affects every pixel in 
the image; therefore it is not recommended for high-end output since it can result in a loss of detail in 
the image. An example of this option appears below: 
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Contrast 
 
The Contrast color option changes the contrast of the image. The contrast of the image can be 
changed from –100 to +100. This adjustment affects every pixel in the image; therefore it is not 
recommended for high-end output since it can result in a loss of detail in the image. An example of 
this option appears below: 
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Hue 
 
The Hue command enables you to define how far around the color wheel you would like to shift the 
colors of the individual pixels in the image. The angle selected reflects the number of degrees or 
rotation around the color wheel from the pixel’s original color. A positive angle indicates a clockwise 
rotation of the color wheel; a negative value indicates counterclockwise rotation. A 180-degree 
rotation in either direction changes each color to its complement. Positive rotation takes red toward 
green, green toward blue, and blue toward red. Negative rotation has the opposite effect. 
 
For more information on the color wheel, see Color Options. An example of this option appears 
below. 
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Saturation 
 
The Saturation command allows you to define how far away from (or towards) the center of the color 
wheel that the color will shift away from the pixel’s original color. For more information on the color 
wheel, see Color Options. An example of the Saturation dialog appears below: 
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Gamma 
 
Gamma measures the brightness of midtone values produced by a device (typically a monitor). 
Intensity Detect values ideally follow a logarithmic progression, because the eye perceives changes 
in intensity as being equal when the ratio of change is equal. For example, we would see a change 
from 0.1 to 0.2 as being equal to a change from 0.2 to 0.4. Gamma is a standard constant that is 
used to calculate the progression. For most CRTs the gamma constant is in the range of 2.2 to 2.5. 
An example of the Gamma dialog appears below: 
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Intensity Detect 
 
Intensity levels range from 0 to 255 for each color plane (red, green, and blue). This dialog processes 
each plane separately. If a value falls within the range, it is raised to 255, and if it falls outside the 
range, it is lowered to 0. An example of the Intensity Detect dialog appears below: 
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Intensity Stretch 
 
The Intensity Stretch command increases the contrast in the image by centering, maximizing, and 
proportioning the range of intensity values across the entire image. 
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Histogram Equalize 
 
The Histogram Equalize option is often the most effective option for bringing out hidden details 
through contrast improvement. Like the Intensity Stretch option, it remaps the intensity values to use 
the full range of 0 to 255. But instead of remapping the values proportionally, it uniformly redistributes 
the values to balance the number of pixels across the range of intensities. Thus, clusters of similar 
intensity values in the original image are spread out, enabling you to see differences that were too 
subtle in the original. 
 
 
Histogram Contrast 
 
The Histogram Contrast option is similar to the ordinary Contrast option, except that it uses a bitmap-
specific middle value. The ordinary contrast option raises all intensity values above 128 and lowers all 
values below 128. The Histogram Contrast option first finds the median intensity value in the bitmap. 
It then uses that median value, instead of 128, as the middle value. An example of this option follows: 
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Invert 
 
The Invert option inverts the colors in the image, making it like a photographic negative.  Inverting the 
image again, will restore the original source image. 
 
 
Fill 
 
The Fill option is a shortcut for replacing the contents of a selection area with a user-specified color. 
 
 
Solarize 
 
The Solarize option applies an effect to the class object's bitmap that mimics the accidental exposure 
of photographic film to light. It does so by inverting all color data with an intensity value greater than 
or equal to the threshold that you specify. 
An example of this dialog follows: 
 

 
 
 
 
Unique Colors 
 
The Unique Colors option will examine the current selection area (or the entire image if there is no 
selection), and tell you the number of unique colors found. 
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Chapter 3 – Screen Camera 
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Screen Camera 
 

Record real-time screen interactions including mouse movements, mouse clicks, drop down menus, 
data field entry, and more. Automatically imports into Lectora as .avi movie or .gif animation. This is 
perfect for software training and simulation. 
 

 
 

The Screen Camera interface is designed to look and operate like a video camera so that it is simple 
and natural to use. Just by pressing a few buttons, you can easily create a screen recording. 
 
Settings - The round button on the left side of the camera is the "Settings" button, which will bring up 
the Preferences panel that enables you to configure all of the preferences for the application. 
 
Record - The button with the red circle is the record button. Pressing this button will start the 
recording process, which begins with selecting the area of the screen to be recorded. The selection 
can be done in several different ways, as described on the General Preferences page. 
 
Stop - The next button is the stop button, which ends the current recording. 
 
Pause - The next button is the pause button, which will pause and restart recording during a 
recording session. 
 
Play - The last button on the bottom right is the play button, which will play the current screen 
recording. The button is disabled until you have recorded at least one movie. 
 
Minimize/Close - At the top left of the interface are the minimize and close buttons, which operate like 
standard minimize and close buttons on all Window applications. 
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GIF or AVI? 
 
One of the first things to decide for any screen recording is whether to record to a GIF file or an AVI 
file. There are advantages to doing it either way, and the answer depends upon your particular 
situation. 
 
The main advantage of an AVI file is that you can record audio at the same time as your video, and it 
all gets stored into one file. This makes creating a demonstration of your software a breeze, enabling 
you to verbally describe to the end viewer of your recording what you are doing step by step as you 
do it.  
 
AVI files can be extremely large though, making them unusable for Internet distribution if you need to 
do a recording of any length. Any multimedia element may also require a plug in on the browser for 
playback, which a user may have to download. 
 
On the other hand, AVI files can be converted to streaming video, which can work very well over the 
Internet, but they require a streaming media server for optimum performance. 
 
GIF files are extremely compact, and enable you to create much longer recordings at a much smaller 
file size. Virtually all browsers natively support GIF’s, so there will be no issues viewing them. 
However, there is no way to include audio with a GIF file, and they do not translate easily into 
streaming video files. 

 
The choice comes down to where you will be deploying your screen recording. For a CD-ROM or 
intranet distributed title, AVI files are a good choice, because they enable you to have an audio track 
along with your video, and size is generally not a consideration. For the Internet, a GIF file might 
make most sense if you can convey your information without the addition of audio.  
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Performance considerations 
 
Recording from the screen can be a very computing intensive task; depending on the size of the area 
you wish to record.  
 
Generally speaking, in order to have the best recording, you should try to record the smallest area 
possible that still conveys the point you are trying to make to the viewer of your recording. Many times 
there is unused space in the recording, which could be cropped to a smaller recording area.  

 
If you must use a large screen area, you can adjust the frames that are recorded per second to a 
lower number. This may cause the recording to be a bit "jumpy", depending on the amount of 
movement that is occurring on the screen, but it will significantly reduce the processing time needed 
to produce the video. 
 
 
Recording to a video 

 
There are many options and possibilities for recording to a video, but let’s go through the steps for a 
basic first recording. 

 
1. Start the Screen Camera application. 
2. Click on the Settings button. 
3. On the general page, select "Record to a video". 
4. Also on the general page, select "Record a fixed size area of the desktop". Use the 

default size of 320x240 
5. Click on OK to accept the values. 
6. Click on the "Record" button. This will activate the area selection mode. 
7. Position the box displayed on the screen over the area you wish to record. 
8. Click the mouse to begin recording. A green frame will be displayed around the area that 

is being recorded. 
9. When you are done, press the stop button to stop recording. 
10. A "Save as" dialog will pop up asking you to name the file. Just accept the default of 

"camera". 
11. If the "Play movie after saving file" setting was checked, it will automatically play your 

recording when you are done. 
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Recording to a GIF 
 

There are many options and possibilities for recording to an animated GIF file, but let’s go 
through the steps for a basic first recording. 

 
1. Start the Screen Camera application. 
2. Click on the Settings button. 
3. On the "General " page of the Screen Camera settings, select "Record to an animated 

GIF". 
4. Also on the general page, select "Record a fixed size area of the desktop". Use the 

default size of 320x240 
5. Click on OK to accept the values. 
6. Click on the "Record" button. This will activate the area selection mode. 
7. Position the box displayed on the screen over the area you wish to record. 
8. Click the mouse to begin recording. A green frame will be displayed around the area that 

is being recorded. 
9. When you are done, press the stop button to stop recording. 
10. A "Save as" dialog will pop up asking you to name the file. Just accept the default of 

"camera". 
11. If the "Play movie after saving file" setting was checked, it will automatically play your 

recording when you are done. 
 
 
Including audio in your recording 
 
Voiceover audio can easily be added to an AVI recording. In order to record audio, you must first 
check a few things on your system: 

1. Ensure that you have a microphone properly connected to the correct input jack on your 
computer. 

2. On the "General" page of the Screen Camera settings, select the "Record to a video" option. 
3. On the Video/Audio page, select the "Record Audio" checkbox. 
4. Click the "Volume/Input" button and ensure that the microphone is selected as your input 

device, and that the microphone volume is turned up. 
5. Once this has been set, begin your recording and speak into the microphone while you 

interact with the screen. 
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Including mouse clicks in your recording 
 
It can be very helpful for a demonstration for the user to know when you are clicking the mouse on an 
item. Screen Camera gives you two ways to include the mouse click in your recording. You can 
include a visual indicator of a mouse click with either a starburst or concentric circles in either a GIF 
recording or an AVI recording. For an AVI recording you have the additional option of including a 
mouse click sound into the video. See the Mouse Click page in the Preferences section for 
information on how to set these features. 
 
 
The general preferences page contains the controls for determining what type of recording to make, 
what to record, and several other miscellaneous settings. 
 

• Record to a video - Checking this option will 
record to an AVI file. This also enables you 
to record audio, and allows you to include 
mouse click sound effects. 

 
• Record to an animated GIF - Checking this 

option will set the program up for recording 
to a GIF file. This will disable any program 
options that are related to audio. 

 
What to record: 
 

• Record a window - After the Record button is
pressed, select the window you wish to 
capture with the mouse. 

 

a 

 
• Record a selected area of the desktop - After 

the Record button is pressed, select the are
you wish to capture with the mouse. 

 
• Record a fixed size area of the desktop - 

After the Record button is pressed, select the fixed size area you wish to capture with the 
mouse. The width and height of the fixed area can be set in the fields below the option. 

 
• Record the entire desktop - Causes the entire desktop to be recorded. This option should 

only be used if your desktop is set to a low resolution such as 640x480. Resolutions larger 
than this can create recordings that are very jumpy and are extremely large. 

 
• Minimize camera window before capturing - This setting will minimize the camera window to 

the Windows Taskbar as soon as the recording is started. This can be useful to clear the 
desktop for your recording, but be sure you know the hotkey to stop recording before you 
select this option. 

 
• Record cursor - This option will include the cursor in your recording. This is the default and 

normally is what you would want for a recording. 
 

• Show capture rectangle - While the recording is taking place, a green frame is placed around 
the area being recorded. If you uncheck this option, the frame will not be shown. 

 
• Play movie after saving file - This option will play the recording immediately after it is saved. 

Uncheck this box if you do not want to play the recording. 
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• Camera window is always on top - This option forces the camera window to be on top of all 
other windows at all times. This can make it easier when windows you are recording may 
overlap the camera window. 

 
 
 
File Preferences 
 
The file preferences dialog handles how and where the recorded file will be saved.  
 

• Prompt for filename after recording - C
this option will cause the application to ask 
you to name the file after each recordin
soon as recording is done, you will be 
prompted with a dialog asking you to name 
the file. 

hecking 

g. As 

 
• Automatic file name using prefix - This option 

will automatically name the file after it is 
recorded. You will not be prompted to name 
the file. The file will be in the directory 
specified in the output folder entry field. The 
file name will be a combination of the prefix in 
the entry field below this option, and a three-
digit number, starting with 001. So, for 

instance, if you created three recordings with the above settings, your files would be name 
Camera-001.avi, Camera-002.avi and Camera-003.avi. 

 
• Output folder - This is the folder that the files will be created in by default. 
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Hot Key 
 
The hotkey preferences page contains the controls for setting the keystrokes that are used to start, 
stop, and pause screen recording.  
 

To set each hotkey, just click on the "Next key 
typed" button and press the key or key combination 
you wish to use to for each of the functions. You 
can use any key in combination with the Ctrl, Shift, 
or Alt key.  
 
The escape key is reserved to cancel the selection 
of the screen area, and cannot be used as a 
hotkey. 
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Video/Audio 
 
The audio and video preferences page enables you to fine tune settings for audio and video codecs 
and compression.  
 

f 
ording. A 

ill 
 

Video: 
• Auto Configure - With this checkbox checked, 

Screen Camera will determine the proper 
frame rate, video codec, and key frame rate 
for your recording. Unless you have extremely 
specific needs, it is recommended that you 
accept the defaults provided by the 
application. 

• Video Setup - This button brings up the 
system’s video codec selection dialog and 
enables you to configure the codec used for 
video recording. 

• Frames - This setting will adjust the number o
frames captured per second for a rec
higher number will produce smoother 
movement, but create larger files and use 
more system resources. A smaller number w
create smaller files but may appear to be
jumpy based upon how much screen action 
will be in your recording. 

 
Audio: 

• Record Audio - Check this box to record audio with your videos. If you won’t be recording 
audio with your video, ensure that this box is not checked, as it will cause your recordings to 
be needlessly large. 

 
• Volume/Input - This button brings up the Windows Record Control dialog that sets the 

microphone volume and sets which device will be used for input. Ensure that the microphone 
is selected as the input device to record your voice. 

 
• Auto configure - With this checkbox checked, Screen Camera will determine the proper 

sampling rate, audio codec, and format for your recording. Unless you have extremely 
specific needs, it is recommended that you accept the defaults provided by the application. 

 
• Audio setup - This button brings up the system’s audio codec selection dialog and enables 

you to configure the codec used for audio recording. 
 

• Audio capture device - If you have multiple recording devices on your system, you can select 
between them here. 
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GIF Options 
 
The image options page contains the controls for setting the palette options for saving GIF files, and 
whether or not the GIF file should run in a continual loop. 
 

 
 
The GIF file format only allows 256 colors, so any image saved as a GIF will have a palette of no 
more than 256 colors. You can adjust the palette used for a GIF in three ways: 
 

• Use optimized palette - This is the default and works best in most situations. Screen capture 
will analyze the image and choose the 256 most used colors in the image as the palette. 

•  
• Use Windows 256-color palette - Windows has specific 256 colors referred to as the 

"Windows Palette". Selecting this option will force the GIF to use that palette. 
 

• Use web palette - The web palette is a 216-color palette that is considered "Web safe". This 
means that if you use these colors, they will be accurately represented on a user’s browser. 
Selecting this option will force the GIF to use that palette. 

 
Checking the Loop the animation box will cause the animation to continually replay when it is viewed 
within a browser. 
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Mouse Click 
 
The mouse click page contains the controls for setting the options for highlighting and playing sounds 
for mouse clicks while recording.  
 
 
Highlight mouse click with - If this box is checked, each time you click the mouse within the recording 
area you will get a visual indication of the click. There are four possible indicators: 

 
• Red concentric circles 

 
• Blue concentric circles 

 
• Red starburst 

 
• Blue starburst 

 
 
 
 
 
 
 
 
 
 
Each of these options will place an indicator exactly 
as it is displayed in the dialog. 
 

• Play click sound effect - If this box is checked, a sound will be inserted into the recording for 
each click up and down sound. The default sounds are standard button clicks, but you can 
replace them with any sound you like. The buttons next to the sound entry fields enable you 
to: 

o  browse for new sound  

o  preview the sound  
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Chapter 4 - Screen Capture 
 

 72



Screen Capture 
 
With Screen Capture, capture and save any portion of the visual image of your Windows screen. You 
may want to do this to create step-by-step software demonstrations, display examples of Web pages 
you've designed, or capture an event on your system. After you've captured a screen image, you can 
manipulate it in a variety of ways, copy it to the Windows clipboard, or save it in a variety of image 
formats. 
 
To get a first look how Screen Capture works, select the "Capture!" item on the menu. Selecting this 
item initiates a screen capture. Depending upon your settings, this will either capture the screen 
immediately, start a timer to capture the screen, or enable the hotkey for capture of the screen at a 
later time. The default settings will capture the entire screen immediately. After capturing the entire 
screen to an image, Screen Capture displays the image in its window. You can save this image to a 
file, or copy it to the Windows clipboard. 
 
Screen Capture includes many options. You can specify whether the capture area is the whole 
screen, an area you select with the mouse, the foreground application window, a window selected by 
the mouse, or a fixed size area of the screen selected by the mouse. You can trigger a capture by 
several different methods - the timer, a hot key, or an immediate capture. Several other capture 
options enable you to specify whether you want the mouse cursor in the image, or to hide the window 
during the capture. There is a mode called "Multicapture mode " which is useful for capturing many 
images in sequence. 
 
Note: Screen Capture cannot save any image on your screen that bypasses the memory buffer on 
your video display board. This includes a "video in a window" feature that is found on some video 
boards used for videotape editing, and also video boards that accommodate DVD players. 
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Screen Capture Toolbar 
 

 
 
 
The Screen Capture toolbar enables quick access to the most frequently used settings and functions 
of the application. 
 

  Capture Now - Initiates the screen capture according to your settings. 

  Settings - Displays the Preferences panel, which will enable you to configure all of 
the preferences for the application. 

 File Open – Enables you to open an existing image.  

 File Save – Enables you to save your image files to disk.   
Note: Screen Capture can open and save to Windows Bitmap (*.BMP), JPEG 
(*.JPEG), or GIF (*.GIF). 

  Cut – Cuts the selected portion from the image. If there is not a selected portion, then 
this feature will cut the entire image. 

  Copy – Copies the image to the Windows clipboard. If there is not a selected portion, 
then this feature will copy the entire image to the clipboard. 

  Paste – Creates a new image from the image in the clipboard. 

  Print – Prints the image. 
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The next section of the toolbar sets what will be captured when the capture button is pressed. One of 
the five modes will be selected as the current capture type. The modes are: 

 

  Capture Foreground Window - Whatever is the topmost window on the screen will be 
captured. 

  Capture Window - After the "Capture Now" button is pressed, you can select the 
window you wish to capture with the mouse. 

  Capture Area - After the "Capture Now" button is pressed, you can select the area 
you wish to capture with the mouse. 

  Capture Fixed Area - After the "Capture Now" button is pressed, you can select the 
fixed size area you wish to capture with the mouse. The width and height of the fixed 
area can be set in the Preferences panel. 

  Capture Desktop - Causes the entire desktop to be captured. 
 
The last section of the toolbar sets the timing of the capture. The options are: 
 

 Capture Immediately - As soon as the "Capture Now! " button is pressed the capture 
begins. 

 Hotkey Capture - After the "Capture Now! " button is pressed, the application will wait 
for the hotkey to be pressed and then start the capture. The hotkey can be set in the 
Preferences panel. 

 Timed Capture - After the "Capture Now! " button is pressed, the application will wait 
the assigned number of seconds and then begin the capture. The delay can be set in 
the Preferences panel. 
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Status Bar 
 
The status bar provides information on the current position of the mouse cursor within an image as 
well as information about the current selection within an image. The status bar is divided into three 
sections: 
 

 
 

• Selection rectangle - The selection rectangle contains the X and Y coordinates of the current 
selection within an image. This is the area that will be used for edit operations such as copy, 
cut, or crop. If there is no current selection, this area will be blank. 

 
• Selection width and height - This is the width and height of the rectangle that is described in 

the first status area. If there is no current selection, this area will be blank. 
 

• Cursor position - If the cursor is over a captured image, the current X and Y coordinates of 
the cursor will be displayed here. If the cursor is not over a captured image, this area will be 
blank. 
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Capturing the screen 
 
For your first Screen Capture, set the capture timing to immediate, and the capture type to desktop. 
Then click on the "Capture!" item on the menu, or the red circle on the toolbar. Selecting this with 
those settings initiates an immediate screen capture of the entire contents of the Windows desktop.  
 
After capturing the entire screen to an image, Screen Capture displays the image in its window. You 
can then save this image to a file, edit it, or copy it to the Windows clipboard. 
 
 
Copying the Image to the Clipboard 
 
If you need to transfer the image to another application, you can copy it to the Windows clipboard. 
Select Copy from the Edit menu to do this. 
 
You can select Cut from the Edit menu to copy the image to the clipboard and delete it from the 
Screen Capture window. 
 
Selecting Paste from the Edit menu will create a new image from a image on the clipboard if there is 
an image on the clipboard. If there is no image on the clipboard, no image will be created. 
 
All clipboard operations act on the current selection in the window. You can select an area of the 
image to act on by clicking the mouse within the image and then dragging the mouse to your desired 
selection. If there is no current selection, the entire image will be used for the operation. 
 
 
Saving the Image to a File 
 
Screen Capture can save an image to a Windows Bitmap (*.BMP), JPEG (*.JPEG), or GIF (*.GIF). To 
save the current image to a file, you need to select Save or Save As from the File menu. You can 
specify a name for the file, and choose or create a folder where you wish to save the image. Press 
Save to save the file. 
 
The GIF file format only allows 256 colors, so the image will have a reduced palette if saved as a GIF. 
You can adjust the palette used for a GIF in the Preferences panel. 
 
A JPEG file can be saved with a quality setting of between 0 and 100. A lower quality setting will 
achieve a smaller file, but the file will not be as visually accurate to the original image. By default, the 
quality setting is at 75, which provides a good balance of image quality and file size. You can adjust 
the quality setting used for a JPEG in the Preferences panel. 
 
Bitmap files are saved in true color non-compressed files. The saved file will be the largest file, but 
will be an exact copy of the image. 
 
 
Editing an Image 
 
Once you have captured an image, you can easily edit it in several ways by using options on the Edit 
menu. 
 
To crop the image, use your mouse to create a selection within the current image. Then choose Crop 
from the edit menu. The image will be cropped to the selection. 
 
Selecting Flip from the edit menu can flip the entire image either horizontally or vertically. 
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You can resize the image by selecting Resize from the edit menu. This will bring up a dialog that will 
allow you to enter the width and height that you desire the image to be. The size change can be 
forced to maintain the aspect ratio of the original image by keeping the "Keep Aspect Ratio" checkbox 
selected. 
 
 
General Preferences 
 
The general preferences page contains the controls for setting the timing of the capture, what will be 
captured, and other miscellaneous settings. 
 

• Hide window before capturing – 
Check this option to hide the 
Screen capture window when 
the "Capture Now!" button is 
pressed. This setting is useful 
when you don’t want the Screen 
Capture window in the image. 

 
• Play sound when capturing - 

This settings controls whether 
the application plays a beep 
sound to inform you of the 
capture. 

 
 
 
 

• Include cursor in capture - 
Depending upon your needs 
you may or may not want the 
cursor included in your image. 
This setting enables you to 
adjust that. 

 
• Multicapture mode - Sets the application up for performing a sequence of captures, such as 

when you want to show the sequence of events when performing a task in an application. 
When in multicapture mode, the application is always ready to capture with the hotkey. After 
a capture, the Screen Capture application will not be brought to the foreground as it normally 
is, so you will be ready for the next capture in sequence. Because of the specific nature of 
multicapture mode, many of the program options are disabled while it is in effect. 

 
Timing - The timing setting enables you to configure when the capture will take place after the 
"Capture Now!” Button has been hit. There are three options: 

 
• Capture Immediately - As soon as the "Capture Now!" button is pressed the capture begins. 

 
• Hotkey Capture - After the "Capture Now!" button is pressed, the application will wait for the 

hotkey to be pressed and then start the capture. The hotkey can be set in the Hotkey page of 
the Preferences panel. 

• Timed Capture - After the "Capture Now!" button is pressed, the application will wait the 
assigned number of seconds and then begin the capture. The delay can be set on the Timer 
page of the Preferences panel. 
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Capture Type - The capture type setting allows you to configure what will be captured after the 
"Capture Now!” Button has been hit. There are five options: 

 
• Capture Foreground window - Whatever is the topmost window on the screen will be 

captured 
 

• Capture Window - After the "Capture Now! " button is pressed, you can select the window 
you wish to capture with the mouse. 

 
• Capture Area - After the "Capture Now! " button is pressed, you can select the area you wish 

to capture with the mouse. 
 

• Capture Fixed Area - After the "Capture Now! " button is pressed, you can select the fixed 
size area you wish to capture with the mouse. The width and height of the fixed area can be 
set in the fields below the option. 

 
• Capture Desktop - Causes the entire desktop to be captured. 

 
Hotkey 
 

 
 
The hotkey preferences page contains the controls for setting the keystroke that can be used to 
initiate the capture of a screen image. These settings are only available if the "Timing" setting on the 
"General " page is set to "Hotkey capture". 
 
To set the hotkey, just click on the "Next key typed" button and press the key or key combination you 
wish to use to initiate the capture. You can use any key in combination with the Ctrl, Shift, or Alt key.  
 
The escape key is reserved to cancel the capture, and cannot be used as a hotkey. 
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Timer 
 

 
 
The timer preferences page contains the controls for setting the delay after the "Capture Now!" button 
has been pressed before initiating the capture of a screen image. These settings are only available if 
the "Timing" setting on the "General " page is set to "Timed capture". 
 
To set the delay, just click up or down on the spinner arrows, or type a number into the delay field. 
The delay can be from 1 to 60 seconds. 
 
You can optionally have the application play a tick sound each second while the timer is running to 
help you gauge when the capture is about to occur. 
 
 
Image Options 
 

 
 
The image options page contains the controls for setting the palette options for saving GIF files, and 
the image quality options for saving JPEG files. 
 
The GIF file format only allows 256 colors, so any image saved as a GIF will have a palette of no 
more than 256 colors. You can adjust the palette used for a GIF in three ways: 
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• Use optimized palette - This is the default and works best in most situations. Screen capture 
will analyze the image and choose the 256 most used colors in the image as the palette. 

 
• Use Windows 256-color palette - Windows has specific 256 colors referred to as the 

"Windows Palette". Selecting this option will force the GIF to use that palette. 
 

• Use web palette - The web palette is a 216-color palette that is considered "Web safe". This 
means that if you use these colors, they will be accurately represented on a user’s browser. 
Selecting this option will force the GIF to use that palette. 

 
A JPEG file can be saved with a quality setting of between 0 and 100. A lower quality setting will 
achieve a smaller file, but the file will not be as visually accurate to the original image. By default, the 
quality setting is at 75, which provides a good balance of image quality and file size. 
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Chapter 5 – Video Editor 
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Video Editor 
 
The Video Editor enables you to play, edit, and convert .AVI format video files. You may want to add 
sound effects to existing videos, merge multiple videos into a single presentation, or copy audio 
tracks out of an existing video - all of these functions are available in the Video Editor. 
 
 
What is an .AIF file? 
 
A video typically consists of a series of compressed images (frames) that are presented at standard 
intervals to the audience. This interval is measured in frames per second, which you typically see 
abbreviated as FPS.  Typical movies range in rates of anywhere from 15 to 32 FPS … the smaller the 
number, the less number of frames that get presented to the user per second of video, the larger the 
number, the more data it requires to present the video to the user. This is a tradeoff between how 
jumpy the end video appears to the user, versus the size of the movie. 
 
The video format used by the Video Editor is the Microsoft AVI file format. The acronym AVI stands 
for Audio Video Interleave.  What this basically means is that the file format represents a series of 
interleaved multimedia streams (both audio and video). When you edit videos using the Video Editor, 
the streams are handled automatically for you as you make the appropriate edits, and the final video 
file will consist of a video stream and an optional audio stream. When you add additional audio clips 
to the video, the Video Editor merges the audio streams into a single audio stream. 
 
 

 83



 
 
Once an existing video is opened, the Video Sample Display will show you the current frame within 
the video and the relative position of the frame within the video as a whole. If you scroll through the 
current video using the slider below the Video Sample Display or the buttons in the Control Panel, the 
Video Sample Display will update with the current frame within the video. In playback mode, the 
Video Sample Display will show the video, as it will be seen when viewed through an external video 
player. 
 
The Video Sample Display will automatically update itself with changes to the source video. If you 
resize the Video Editor window, the Video Sample Display will expand/contract itself to make the best 
use of the available space within the Video Editor window. If you want to increase or decrease the 
size of the video displayed within the Video Sample Display, use the Zoom factors available from the 
menu. 
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Video Editor Control Panel 
 
The Control Panel allows you to perform the standard video player operations on the current video 
(play, stop, pause, etc.). The individual controls will enable/disable themselves based on the current 
operating mode of the Video Editor. 
 

 
 
The functions of these buttons are as follows: 
 

• Stop - stops the Video Editor while in playback mode. 
• Play - will begin playback of the current video. If a selection is currently active, playback will 

consist only of the current selection. 
• Pause - will suspend playback of a video. Pressing this button a second time will resume 

playback of the video. 
• Go to Start - will move the current position in the video to the beginning of the current 

selection. A second press of this button will move the current position in the video to the start 
of the video (time 0:00.00). 

• Prev Frame - will move the current position in the video to the previous frame. 
• Next Frame - will move the current position in the video to the next frame. 
• Go to End - will move the current position in the video to the end of the current selection. A 

second press of this button will move the current position in the video to the last frame of the 
video. 

• Begin Selection - will mark the starting point within the video that you wish to edit. 
• End Selection - will mark the ending point within the video that you wish to edit. 

 
Note: If you attempt to play the video and nothing appears to happen, make sure that you have not 
set the beginning and the ending point of the selection to the same frame within the video. 
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Time Display 
 

 
 
The Time Display enables you to visually see (in addition to the selection within the slider in the Video 
Sample Display) the currently selected portion of the video, the length of the current selection, and 
the position within the current video. If there is no current selection, the length Selection represents 
the length of the entire video. The Current Location always represents the position within the video as 
a whole (not within the current selection). 
 
 
Compression Options 
 
The Video Editor enables you to change the compression options when you save your modified 
videos, or, when you want to just convert existing videos. From the File menu, select the Save 
Options menu choice to invoke the Compression Options feature of the Video Editor: 
 

 
 
The Compression Options dialog enables you to select the stream, which you want to modify the 
compression options to. If you select a video stream, and then press the Options button, another 
dialog will appear: 
 

 
 
The Video Compression dialog box enables you to change the type of video compressor CODEC 
(Compression/Decompression module) used for the images stored within the video stream, the 
quality of the compression, and the regulation of key frames within the final video stream. 
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If you select an audio stream, the following audio compression dialog will appear. 
 

 
 
This will enable you to change the type of audio CODEC used within the audio stream, the number of 
samples per second (listed in Hz), the size of each data sample (8 or 16 bit), and the whether the 
audio is mono or stereo. 
 
Realize that each of these options can have a significant effect on the overall size of the final video 
and to the quality of the video as it is presented to your audience. 
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Selecting Video Range 
 
To select a range within the Video Editor, use the previous and next frame buttons in the Control 
Panel or the slider under the Video Sample Display to isolate the frame that you want to use to start 

your selection. Press the  Begin Selection button to set the starting frame for the selection. Then 

navigate to the ending frame and use the  End Selection button to set the end of the video 
selection. The current selection will then be updated in the Time Display and will be shown in the 
highlighted portion of the slider. 
Copy/Paste/Delete Video segments 
 
When you have a portion of the video selected (see Selecting Video Range), you can use the typical 
editing commands of Cut, Copy, and Delete. Cut will delete the portion of the selected video and copy 
the deleted portion to the Windows clipboard, while Delete will just delete that portion of the video. 
 
When you try to Copy a selected portion of a video, you have three options: 
 

1. Copy both Audio and Video - will copy streams of both types to the Windows clipboard. This 
is the default action and will automatically be done when you use the keyboard shortcut 
CTRL-C 

2. Copy Video Only - will copy only the video streams to the Windows clipboard. 
3. Copy Audio Only - will copy only the audio stream to the Windows clipboard. This puts the 

selected portion of the video up on the clipboard in a WAVE format, which can be used in 
conjunction with audio editors to manipulate the sound clip. 

 
When you attempt to paste into the current video, only the current position in the video file is relevant 
(any video selection is ignored).  There are three possible combinations of multimedia that you can 
attempt to paste: 
 

1. Pasting both Video and Audio - will be completed as an INSERT operation. The video and 
audio in the paste buffer will be inserted at the current location (not selection) in the video. 

2. Pasting Video Only - will be completed as an INSERT operation. The video in the paste 
buffer will be inserted at the current location in the video. Silence will be inserted in the audio 
stream of the current video to keep the audio track in sync with the video. 

3. Pasting Audio Only - will be completed as an OVERWRITE operation. The audio in the paste 
buffer will overwrite the audio in the current video at the current location. 
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Tools 
 
The Tools menu includes several common tasks that you will want to use while editing your videos:  
 

• Crop - deletes the unselected portion of the video. 
• Insert Audio Clip - select an external audio file (in 

WAVE format) that you want inserted into the current 
video at the current location. This task automates the 
process of opening an audio in an audio editor, copying 
the contents of the audio to the Windows clipboard, and 
pasting the audio into the video. 

• Remove Audio Stream - will strip all audio streams from 
the video file. 

• Master Volume – launches the Windows Volume control application 
 
 
Zoom 
 
The Video Editor is able to display the frame data of the video stream at one of five different 
resolutions: 
 

• 4x - four times larger than normal display size 
• 2x - two times larger than normal display size 
• 1x - normal display size 
• ½ - one half of the normal display size 
• ¼ - one quarter of the normal display size 
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Chapter 6: QTI 
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What is QTI? 
 
QTI stands for Question Test Interactive that is XML (Extensible Mark-up Language) formatted data 
defined by the IMS Global Learning Consortium Inc.  
 
Lectora Professional Publisher Suite meets Version 1.2 IMS specifications, which can be downloaded 
from http://www.imsproject.org.   
 
QTI enables you to import an existing test or test questions developed in other applications that 
meets the QTI standard into Lectora. It works the same in the reverse as well. If you create a test in 
Lectora and export it to QTI, that test can be imported into other applications that again, meet the 
same standard. This feature is helping content developers move toward interoperability between 
multiple products. 
 
 
Exporting to QTI 
 
Once your test is created in Lectora. Remember to save, highlight the test in the left hand pane and 
click on the File drop down menu. 
 

 
 
Note: Make sure you highlight the 
test in the left hand pane. If there 
isn’t anything selected that can be 
exported to QTI, then a warning 
message will display: 
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Once your test is exported to QTI, additional files will be created in your C:\My Titles\course name\  
 

 
 

The .dtd and .xml are the files that will be used while being imported into a different QTI compatible 
software application. 
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NOTES: 
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